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Installation 
 
Extract the files from the Octane_1022-02.zip file into the ../Sketchup../Plugins/ folder, keeping the sub-folder 
structure for several of the files – see below. 
 
You must ‘extract’ the files, keeping any sub-folders – so do not uncompress everything directly or open the 
archive, select and then drag+drop the files [unless you are sure what you are doing] - as doing it that way you 
could end up with files in the wrong relative relationships.  On a PC you should use the ‘extract’ option in your zip 
application; on a Mac a double-click might not keep them in their sub-folders, so you should use right-click 
‘unarchiver’ or ‘stuffit_expander’… 
 
If you are unclear about where your ‘Plugins’ folder might be then type [or copy+paste] this line into the  
Window > Ruby Console: 
 
  Sketchup.find_support_file("Plugins") + <enter> 
 
Typically the PC path that is returned is: 
 
  C:/Program Files/Google/Google SketchUp 7/Plugins 
 
Whilst typically the Mac path that is returned is: 
 
  Macintosh HD/Library/Application Support/Google Sketchup 7/SketchUp/Plugins 
 
So there should be the following: 
 
In the folder ../Plugins/ 
 
  Octane_loader.rb  The file that loads the current script below. 
  win32ole.so   A file used by the PC version of the tool 

[since this does nothing on a Mac and could be discarded, on a Mac]. 
  README.txt   This file can be discarded - it only explains the initial installation. 
 
And in the folder ../Plugins/Octane/ 
 
  Octane_1022.rb  The script that sets up the Octane Render Sketchup Exporter tool. 
  OctaneDialog.html  The file that is used to make the main web-dialog for that tool. 
  OctaneDialogStrap.png The logo image used by the html file. 
  OctaneDialogBack.png  The background image used by the html file. 
  OctaneToolbar16x16.png An image used for the Octane Render toolbar ‘small’ button. 
  OctaneToolbar24x24.png An image used for the Octane Render toolbar ‘large’ button. 
  OctaneHelp.pdf  This Help file. 
 
And in the folder ../Plugins/Octane/OctaneFolderBrowser/ 
 
  folder_browser.html A file used to make the special folder-browser dialog. 
  folder_browser.js  A file used with the special folder-browser dialog. 
  folder_browser.css  A file used with the special folder-browser dialog. 
  folder.png    The image used for the folder-icons in the special folder-browser dialog. 
  folderup.png   The image used for the folder-up-icon in the special folder-browser dialog. 
 
And in the folder ../Plugins/Octane/OctaneSlider/ 
 
  slider.js   A file that is used to make the main dialog’s sliders. 
  slider_Bar.png  The image used for the slider’s ‘bar’. 
  slider_Btn.png  The image used for the slider’s ‘button’. 



Usage 

 
After installation and the restart of Sketchup you should have an additional menu item to run the tool 
 
File > Octane Render… 
 
There is also an Octane Render toolbar – by default it is not active – you can activate it from the matching  
View > Toolbars menu item [or Mac equivalent].  Clicking its button is the same as picking the main menu item. 
 
There is also a ‘right-click’ context-menu - Octane Render… – it also works the same as the main menu item.  
 
Alternatively you can also type octane into the Ruby Console… 
 

The Dialog 
 

 
[showing the default settings]. 
 



The first section is “Project Configuration”. 
 
On the first run you will be pressed to choose an Octane Render Binary file – the application that the tool will use 
to process the render.  It will be remembered with Sketchup for any future sessions. 
 
On a PC it should be the octane.exe, on a Mac it should be the octane.app. 
 
Should the specified Octane binary file become unavailable between sessions you will be prompted to select an 
alternative. 
 
After the initial set up you can change to another Octane application by clicking the Browse button. 
 
 
The Project Path initially defaults to the current model’s 
folder – you can change this by clicking the Browse button 
at any time.  This special folder-browser will open [it 
should start in the current Project Folder].  Highlight the 
desired folder and press OK: the current folder path is 
displayed along the top of the dialog, to navigate up 
double-click the topmost ‘folder-up’ icon [../], to navigate 
down into any folder double-click on its icon.  You can add 
a ‘New Folder’ into the current folder by clicking the button 
– the new folder will be made and then temporarily shown 
at the top of the list of folders so that you may find it 
easily, useful in longer lists. 
 
 
 
 
 
 
 
 
 
 
The Project Name initially defaults to the model’s name, with any spaces replaced with an underscore: 
my_model.skp gives my_model for the Octane my_model.ocs file], you can type in another name if required; if the 
.ocs file doesn’t exist then it will be made if you run the rendering parts of the tool.  Alternatively, you can click on 
Use Existing Project button to find an existing .ocs file… then both the Project Path and the Project Name will be 
changed to suit that selection.  Note that a previously made .ocs will be ‘relinked’ and will not update existing 
materials’ textures etc – so with major changes it is best to start a new .ocs or rename the old one. 
 
 
The dialog also shows the model’s units settings – Native Unit Size – this is non-editable and is for information 
only [and to keep consistency with other exporters’ UIs] - all dimensions used within the tool are automatically set 
to the units required by Octane – i.e. ‘meters’. 
 
 
To the right of this is a Help button that opens this file [OctaneHelp.pdf] - if it is found in the ../Plugins/Octane/ 
folder. 
 
 
These settings are remembered during the session and if you save the model when you close it, then they are 
remembered with the model. 
 
 



The second section - “Export Configuration” - lets you choose what settings to use with the export [if any]. 
 
Film 

Resolution    Initially disabled, if enabled you can change the following: 
Width    The image width, defaults to the screen width. 
Height   The image height, defaults to the screen height. 
Percentage The standards are 100%, 75%, 50% and 25% which are applied to the 

current width and height settings. 
 The other drop-down option is Reset with reverts to the model’s screen 

width and height. 
Camera 

  Export Camera Initially enabled, you can change the following settings: 
         Active Camera This defaults to from <Current View>. 
 Other in the drop-down options [if there are Scenes tabs available] are 

from <Current Scene> and then every available ’Camera’ from the 
‘Scenes’, listed in their current order [it includes all Scenes – even those 
that are excluded from an animation].  If you select one of these ‘scene’ 
options then the model will adjust automatically to that Scene tab – 
remember that this might also affect the ‘visible geometry’ as there can be 
different hidden and layer states with each Scene; and only ‘visible 
geometry’ is exported to the OBJ/MTL etc.  Note that if this Export Camera 
option is enabled and Render Animation is invoked then this selected 
Camera will be ignored and each animation frame’s Scene’s Camera is 
used instead [see below]. 

 
Lens Aperture Radius Initially disabled, default=1, you can type in any value between 0  

and 1 – e.g. 0.25, or use the slider to change the value.  When typing a 
value the slider will update to the new value when you press enter or the 
text input box loses focus. 

 
Focal Depth (m) Initially disabled, default=5, you can type in any value > 0, or use 

the slider for values up to 100, if a value > 100 is desired then type in that 
value – the slider will stop at the maximum extent (100).  When typing a 
value the slider will update to the new value when you press enter or the 
text input box loses focus. 

 
Motion Blur   Initially disabled, default=Next, choose Next/Previous – to blur  
    between scenes in animations. 

     If the Active Camera=from <Current View> then Motion Blur is  
     inoperable in the Render Frame mode as it has no ‘next/previous  
     scene. 
     If there is no ‘next’ scene then the first scene is used, if there is no  
     ‘previous’ scene then the last scene is used. 

Note that if this option is enabled and Render Animation is  
invoked then the camera for the Scene next or previous to the animation 
frame’s Scene will be used in each frame, if it is available. 

Daylight Environment 
         Export Sun Direction Initially disabled, you can choose the following setting: 
   Light Source This defaults to Sun from <Current View>. 
     Other options in the drop-down are Sun from <Current Scene> and  
     then any available ‘Sun’ from the ‘Scenes’, listed in their order. 

Note that if this option is enabled and Render Animation is  
invoked then in  each animation frame that Scene’s Sun will be used 
instead. 

GPU Devices 
  Specify GPU Devices Initially disabled, you can choose the following settings 

Default is 0 – choose from 0, 1, 2, 3 as the GPU[s] to use: 
NOTE: these settings can currently cause Octane to hang on startup if 
enabled AND any number is checked 0-3 at all.*** 
Temporary Solution: try it, and if it hangs then next time don’t try to specify 
the GPU using these settings… 
 
 



The third section - “Export” - lets you choose the type of render - either 
 
Frame 

Export OBJ/MTL Only Click this button to export the current model as OBJ/MTL to the  
path defined earlier [and if appropriate, any Textures are put into a sub-
folder with the same name + _Textures [which is made if it doesn’t exist].  
The OBJ file is set to Octane’s required units ‘meters’, has triangulated 
faces etc…  All Geometry, Groups, Components and Images [that are not 
‘hidden’ or on non-visible layers] are exported, as separate triangulated 
faces, with their materials or textures.  Note that UV-mappng of textures 
[position/scae/rotate/etc] within the SKP is supported, but if you have 
‘skewed’ a texture that cannot be transferred into the OBJ/MTL format – 
so in that rare case, before running this tool, in the SKP right-click the 
affected face and select ‘Make Unique Material’ – a new ‘cloned’ textured-
material will be made with the image having a built-in distortion to suit 
[unfortunately this is not (yet) available as an automated method through 
the current SUp API, but it could be added to this tool after an appropriate 
update to the API]. 

 
or 
 
Render Frame  Click this button to export the OBJ/MTL as described above, and then  

automatically open Octane.   
A new OCS is made if it doesn’t exist. 
A minimized cmd window called Render Cmd opens to activate the OCS; 
it remains open whilst the OCS itself is open – on a PC this cmd window 
can be closed at any time, and it will finally close with the OCS anyway. 
Octane starts to render the OCS using the various export settings you 
have selected – the s/px is automatically set to the standard maximum 
[16000] which you are unlikely to want to exceed;  note that you can pause 
or stop the rendering at any stage and/or change other settings in the 
OCS manually. 

 
or 
 
Animation 

Image Output This defaults to the Project Path that you have set above, with 
img00001.png added as the first image-name – you can enter an 
alternative name or path.  Alternatively to change the folder you can click 
the Browse button, and a special folder-browser will open - see the Project 
Path example above.  Highlight the desired folder and press OK: the 
current folder path is displayed along the top of the dialog, to navigate up 
double-click the topmost ‘folder-up’ icon [../], to navigate down into any 
folder double-click on its icon.  You can add a ‘New Folder’ into the current 
folder by clicking the button – the new folder will be made and then 
temporarily shown at the top of the list of folders so that you may find it 
easily, useful in longer lists. 
Again the image-name configuration will default to img00001.png which 
you can then adjust as desired.  You can type in any image-name here, 
after the folder separator (\ or /); but remember that it must have a 
‘numerical’ ending so it can be incremented (like anim9009.png) and it 
must also have a .png suffix.  The output images in the animation 
sequence will all be saved into this Image Output folder; their names will 
increment based on the image-name format you have given – e.g. 
img00001.png, img00002.png, img00003.png etc 

 
Start/End Frames These are listed in pull-downs from all of the available Scenes [Cameras], 

but only those Scenes marked in the Sketchup ‘Scene Manager’ to be 
‘included in animation’ – i.e. without enclosing (…) in their tab label… 

 If there none or only one available Scene tab then these drop-downs and 
‘Step’ are disabled, as are the ‘Pixel Samples’ options and the ‘Render 
Animation’ button. 

 
Start Frame Defaults to the first Scene, it can be any of the available Scenes except 

the last one. 
 



 End Frame   Defaults to the Scene after the Start Frame’s Scene [typically the second  
     Scene], it can be any Scene later than the Start Frame’s Scene. 

 
Step    Defaults to ‘1’, the available Steps are listed in a pull-down determined  
    from the Start/End Frames selected. 
 
Pixel Samples Defaults to Medium (256 s/px), choose from various setting, or type in a 

Custom value in the box to the right – it must be at >= 1; but 8 is small – 
use these low settings for quick testing of animation frame-sets ! 

 
Render Animation Note that previously you must have rendered a single frame to set up the 

Project OCS’s default OBJ file before using this option – otherwise you will 
get an error message and will need to abort the animation [see below]. 

 
Click this button to start the processing of the frame-set specified. 
Note that the selected Scenes’ Cameras, Motion-Blur and Light-Source 
are used if the respective Export Configuration options are ‘checked’ - 
their Frame Render specific Scene/Light-Source settings are ignored for 
the animation – these are taken from each frame’s scene-tab settings. 
Other ‘checked’ configurations will also be used, e.g. ‘Focal Depth’. 
 
There is then this dialog… 

 
It asks if you want to ‘Animate just the Camera’… 
 
The default reply is Yes and this will make one OBJ/MTL file based on the 
settings of the first frame’s Scene tab [using that tab’s hidden/layer states 
etc].  The series of images that are then made animate the camera for a 
walkthrough, fly-round or orbit as the scenes will determine – the ‘visible 
geometry’ in every frame is fixed by the first frame’s Scene tab’s settings.  
This is the standard and quickest option as only one OBJ/MTL is made. 
 
If you answer No you opt for animating the camera and the ‘visible 
geometry’ in each individual frame’s Scene tab: because each tab can 
have different hidden/layer states [as with 3

rd
 party Animation plugins] or 

have even ‘observers’ to move/modify objects between scenes [as with 
the 3

rd
 party plugin SketchyPhysics] a separate OBJ/MTL file is then 

necessary for every frame.  This can extend the processing time 
dramatically, so this option is not recommended unless you really want to 
‘animated objects’ within the animation’s image set.  If this option is 
selected then the tool will make an OBJ/MTL file for every frame before 
starting to render them [these files are temporary and are deleted when 
the tool’s main dialog is closed].  If you close this dialog or select Cancel 
nothing is processed and the main dialog reverts for your next choice... 
 
As the animation sequence is processed the main button’s title changes to 
say ‘Rendering Animation, Please Wait…’’, and it is then disabled [PC] 
during the OBJ/MTL creation and subsequent image rendering.   
When the image processing starts a minimized cmd window called 
Animation Cmd opens in the Taskbar/Dock area and that opens the OCS 
– once for each frame in the animation – it remains open whilst Octane is 
processing the whole animation sequence.   



To abort the image rendering iteration part way through you can close this 
‘cmd’ window early [the Command-line prompt also reminds you of this]: 
when aborted the OCS will complete the current frame’s render and then 
stop without processing any further frames in the set.  On the completion 
of the set of images [or its early cancellation], the dialog’s button becomes 
re-enabled and its title reverts to ‘Render Animation’  and it can be used 
again... 

 
 
General 
 
All of the current settings are remembered during the session whenever the tool is restarted, and if you save the 
model, then the settings are remembered with the model and are reused when the model is reopened and the tool 
is activated.  Certain ‘volatile’ settings [like Scene names] will be reused if they are still available [e.g. you haven’t 
deleted that Scene in the meantime], otherwise they will ‘default’ again. 
 
The temporary cmd/command files and the ‘anim’ OBJ/MTL files are automatically deleted whenever the tool is 
closed; however, the main OBJ/MTL files are always retained as they are needed by the Project’s OCS. 
 
 
 

Version: 
 
[full] 
1022. 
01 20100804 First issue. 
02 20100805 Toolbar icon paths made more robust. 
 
 

Known Issues:*** 
 
The non-transfer of any new materials’ transparency on a re-linked render/_anim etc needs to be advised on 
further by RS.  It seems preset in Octane and unrelated to the exporter’s files themselves [obj/mtl] which do contain 
the new materials with all of their values correctly set.  Clearly you don’t want to overwrite any values of materials 
that were previously loaded, and which you might have subsequently changed in Octane itself: but on a re-link 
surely any newly added materials that Octane finds should be used with their initial setting taken from the mtl-file– 
and not ‘defaulted’ as seems to occur now??  RS need to comment… 
 
Currently using the GPU settings can sometimes cause Octane to ‘freeze’ on startup if enabled AND any number is 
checked 0-3 at all, or you specify more GPUs than you have.  Temporary Solution: try it, and if it hangs next time 
don’t try to specify the GPU using these settings – perhaps some CUDA settings ?  RS need to comment… 
 
If you have an early version OS on your PC – e.g. XP - please upgrade your Internet-Explorer to at least v7 – v8 
recommended – as earlier versions of IE can create java-script issues when run with Sketchup’s API based web-
dialogs…  With the first ‘full’ release both PC and MAC versions should now work exactly the same. 
 
 
Feedback welcome… 

 
 
TIG 


